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How to - how_



Copy Tracks Dialog
This is a description of the Copy Tracks Dialog.    This dialog is used to copy disc information 
such as disc name, artist, label, category, comments, and track names to the windows 
clipboard.    The information can then be pasted into any windows application such as 
Notepad or MS Word for Windows.

To get information on a function or area, click on it in the graphic below.



Cue Dialog
This is a description of the Cue Dialog.    This dialog is used to position the CDROM to an 
exact position on the disc.

To get information on a function or area, click on it in the graphic below.



Database Options Dialog
This is a description of the Database Options Dialog.    This is the dialog that is used to 
configure the options that effect the database.

To get information on a function or area, click on it in the graphic below.



Disc Database Dialog
This is a description of the Disc Database Dialog.    This dialog allows the user to search the 
database of CDs and displays all CDs meeting the selection.

To get information on a function or area, click on it in the graphic below.



Display Options Dialog
This is a description of the Display Options Dialog.    This is the dialog that is used to 
configure the options that effect the look and feel of the main window.

To get information on a function or area, click on it in the graphic below.



Edit Disc Data Dialog
This is a description of the Edit Disc Data Dialog.    This dialog displays all information about 
a particular CD.    This dialog can be used to enter the disc name and track names.

To get information on a function or area, click on it in the graphic below.



Export Options Dialog
This is a description of the Export Options Dialog.    This dialog displays the options for an 
export of disc data.

By selecting First record to contain field names, Text Delimiter of Double Quotes, and Field 
Separator of Comma most databases and word processors will handle the exported file by 
default.

To get information on a function or area, click on it in the graphic below.



Icon Window
This is a description of the CD Wizzard Icon.    The icon is updated with the CD player's 
current status.

The right mouse button may be pressed on the icon to toggle PLAY or PAUSE.

To get information on a function or area, click on it in the graphic below.



Layout Options Dialog
This is a description of the Layout Options Dialog.    This is the dialog that is used to 
configure the options that effect the layout and placement of parts on the main window.

To get information on a function or area, click on it in the graphic below.



Main Window
This is a description of the CD Wizzard Window.    The window is updated with the CD player's
current status.

To get information on a function or area, click on it in the graphic below.



Options
CD Wizzard is very customizable.    The user has many options that can be set to his/her 
preference.    The options are of the following categories:
Display Options - options to configure the main window's look and feel.
Layout Options - options to configure the main window's layout.
Playback Options - options to configure the playing of CDs.
System Options - options to configure the user's CD-ROM Drive and other system settings.
Database Options - options to configure the user's disc database.



Player Options Dialog
This is a description of the Player Options Dialog.    This is the dialog that is used to configure
the playing mode for CDs.

To get information on a function or area, click on it in the graphic below.



Program Tracks Dialog
This is a description of the Program Tracks Dialog.    This is the dialog that is used to select 
the tracks and order of play in programmed mode.    The tracks can be dragged and dropped
from the track list to the programmed tracks listbox.

To get information on a function or area, click on it in the graphic below.



Registration Dialog
This is a description of the Registration Dialog.    This is the dialog that is used to register this
software product.

To get information on a function or area, click on it in the graphic below.



Select CD Audio Input Dialog
The Select CD Audio Input Dialog is presented as a reminder to select the source for CD 
Audio Output on your mixer program.    The mixer program that came with the user's sound 
card must be used to select the source that the CD Audio Output is connected.    This allows 
the music from the disc to be recorded.    If the CD Audio source is not set, the samples will 
be blank due to no input source selected.    The user may wish to try different volume levels 
with the mixer to determine the best setting for the recording of the samples.

After the samples are recorded the user may wish to reset the mixer to the previous 
settings.

To get information on a function or area, click on it in the graphic below.



Small Window
This is a description of the CD Wizzard Small Window.    The window is updated with the CD 
player's current status.

The small window will remember its current screen location from execution to execution.    
Also, if CD Wizzard is exited in small mode, CD Wizzard will restart in small mode.

To get information on a function or area, click on it in the graphic below.



System Options Dialog
This is a description of the System Options Dialog.    This is the dialog that is used to 
configure parts of your computer system for use with CD Wizzard.

To get information on a function or area, click on it in the graphic below.



Track Playlist Dialog
This is a description of the Track Playlist Dialog.    This is the dialog that is used to select a 
track to play from the playlist.    The user selects the track and double clicks or presses the 
play button.

To get information on a function or area, click on it in the graphic below.



Windows - wnd_



Always on Top
This command will cause the CD Wizzard icon and the small mode window to have the 
Always on Top attribute.    This will display the icon or small window on top of all other 
windows, even if it is not the currently selected application.



Artist
This is the artist of the disc currently being played.    This was entered from the Edit Disc 
Data Dialog.



Artist Field
This field is used to enter the artist of the disc.

This field is a drop down listbox.    The user may select the a previously entered item from 
the list.    When the listbox is dropped down, as the user types any matching list entries are 
automatically displayed.



Background
These radio buttons allow the user to select the background for the main window.    The 
different backgrounds are marbled, brushed aluminum, hammered steel, gray, and black.    
When a background is selected, a small sample is displayed.    When black is selected, the 
entire display is switched to black including the button backgrounds.



Button Color
These radio buttons allow the user to select the color of the buttons on the main window.    
The different colors are black, green, blue, and red.    When a color is selected a preview of 
the button color is displayed.    When the button color is black and the background color is 
black, the button color will be set to white so, the buttons can be seen.



Caption Bar
The caption bar of the window may be used to move the window around the screen.    To do 
this, the user must click the left mouse button and then drag the window to a new location.   
Release the mouse button when the desired location is reached.



Category Field
The category dropdown listbox allows the user to select a category for the disc.    Many 
categories are available such as Rap, Classic Rock and Vocalists.

This field is a drop down listbox.    The user may select the a previously entered item from 
the list.    When the listbox is dropped down, as the user types any matching list entries are 
automatically displayed.



CD-ROM Audio Source
These three radio buttons select the source that CD Wizzard uses to control the volume of 
the audio playback.    The three source follow:
CD Audio Port - this is the internal port on the sound card, usually used for internal CD-ROM 
drives.
Line-In Port - this is the input jack on the back of the sound card, usually used for external 
CD-ROM drives but, sometimes for internal drives with a line-out connector.
CDROM Direct - selecting this button causes CD Wizzard to directly access the CDROM to 
control the volume.    This bypasses any mixer program on the system.    Some CDROMs do 
not allow the volume to be changed.    They only allow full volume and no volume.

Please refer to your CD-ROM drive and Sound card documentation for further details on 
which type of setup you have.

Note: If you do not have a sound card, CDROM Direct is the only way to control the sound of 
your CDROM.



Comments
The comments field is a free-form area that can be used to enter any information about the 
CD.    It will be saved and redisplayed when that CD is edited.    This area may contain a few 
lines of text about the disc.



Composer Field
This field is used to enter the composer of the disc.

This field is a drop down listbox.    The user may select the a previously entered item from 
the list.    When the listbox is dropped down, as the user types any matching list entries are 
automatically displayed.



Compression Rate
These push buttons are used to select the level of compression to be used during the 
sampling.    The three levels allow the user to experiment with the best rate for disc.    The 
highest level uses less disk space 4 to 1 compression but the sample's quality suffers.    The 
normal rate is a compromise on size 3 to 1 compression and quality.    The low rate uses 
more disk space 2 to 1 compression but has the best quality.



Cue Position
These fields are the position to Cue to or to position to.    The track number, minute, second 
and frame may be entered.    The track entered must be in the current playlist if in 
programmed mode.



Data
These fields are the user's return address data.    The user must enter all information needed 
so that mail can be delivered to the correct address.



Disc Length
This is the total length of the current disc in minutes and seconds.



Disc Name List
This is the list of all disc names that have been entered into the disc database.    The user 
will select a disc name and then press the Edit or Delete button.    Double clicking a disc 
name will edit that disc's data.



Disc Name
This is the name of the disc currently being played.    This was entered from the Edit Disc 
Data Dialog.



Disc Name Field
This field is used to enter the name of the disc.



Display Output Meter Window
Selecting this checkbox will cause the Output Meter to be displayed on the Main Window.



Drive
This combobox contains the drive letters of all installed CDROMs on the system.    Please 
select the drive letter of the drive you wish to control the volume.



Embossed Text
Selecting this checkbox will cause all text in the disc name, track name and status bar to be 
embossed or have a sunken 3-D effect.



Field Names
These fields are used to specify the names of Field1 and Field2.    These fields can be 
renamed by the user to whatever meaningful name that is desired.    For instance, "Where 
Purchased" and "Price".    The names entered will be used throughout CD Wizzard.



Field Separator
The Field Separator dropdown listbox lists the different characters that can be used to 
separate fields in the exported file.    The separator may be a comma (,), space ( ), tab 
character, or carriage return - line feed.    An example of comma delimited fields is:

"Field A","Field B","Field C"



Fields
These Fields are used for whatever the user decides to put in them.    The names of the fields
may be changed by going to the Database Options Dialog and renaming the fields.



First record to contain field names
The First record to contain field names checkbox is used to indicate if the first record 
exported with contain the field names of the CD Wizzard data fields.    Most databases and 
word processors will optionally use the first record as the field names.    However, this 
feature allows automatic creation of a database or mail merge word processing document.



Include track names in export
The Include track names in export checkbox is used to indicate if the track names are to be 
included in the exported file.



Include track lengths in export
The Include track lengths in export checkbox is used to indicate if the track lengths are to be
included in the exported file.



Label
This field is used to enter the label or company that produced the CD.

This field is a drop down listbox.    The user may select the a previously entered item from 
the list.    When the listbox is dropped down, as the user types any matching list entries are 
automatically displayed.



LED Color
These radio buttons allow the user to select the color of the LED Displays on the main 
window.    The different colors are green, yellow, blue, and red.    When a color is selected, a 
preview of the LED color is displayed.



Maximum Number of Tracks
This field is the maximum number of tracks to be exported.    Even if a disc contains more 
tracks than this number only this maximum number will be exported.    This is useful for 
some word processors that can not handle a large amount of columns.



Minutes
This is the number of minutes that may be used as the length of time to be programmed.    A
number between 1-99 must be entered.    The spinbox on the right may also be used to 
increase or decrease the number of minutes.    After the number of minutes is entered, press 
the Set Tracks button to program the desired track length in minutes.



Mixer Name
This is the name of the mixer program for the user's sound card.    The mixer program is used
to set the volume of inputs and selects which inputs are currently being used.

This field is not editable.    The Browse button should be used to select the mixer program.    
The Clear button can be used to clear the field.



Normal Mode
The normal mode of playback will play all tracks of the CD in the original order.



Number Found
This fields is the number of discs found in the disc list for the Search For criteria.



Output Meter Display
This is the display of the Output Meter.    The display has an automatic level control that 
adjusts the display based on input level.    If the display is just a line, then most likely CD 
input is not selected in the mixer.    The user must press the Mixer Button and select CD 
input.



Playback Mode
This is the current playback mode of CD Wizzard.    It can be Normal, Shuffle or Programmed.



Program Mode
The program mode of playback will play all tracks of the CD selected by the user in the 
Program Tracks dialog.



Programmed Length
This is the total length, in minutes and seconds, of the currently selected tracks that have 
been added to the Programmed Tracks listbox.



Programmed Tracks
This is a listbox that lists all the tracks that have been programmed by the user.    If a track is
selected, the user may press the Clear Track(s) button to remove that track.    A track may be
clicked on and dragged to the trashcan icon to be removed.    A track may also be removed 
by double clicking the track.



Replay Mode
This is the replay mode of CD Wizzard.    The dropdown listbox contains the options No 
Replay - do not replay at all, Replay Current Track - replay the current track continuously, 
and Replay Current Disc - replay the current disc continuously.



Replay Mode Display
This is the current repeat mode.    The three modes are none, track and disc.    Track and disc 
will repeat either the current track or disc.    The user clicks on the Repeat Mode to toggle the
next mode.    It can also be changed from the Player Options Dialog.



Search For
These fields are the fields to be searched for.    The strings entered in the fields are searched 
for in the entire field.    For example, the entered data: "at" will find fields : "Bat", "Attempt", 
and "Bath".

For a disc to be selected all fields must match.    So, if search data is entered in the disc 
name, artist, and composer fields a disc must match all three to be selected.

The Composer, Artist, Label, and Category fields are drop down listboxes.    The user may 
select the exact item to be searched for from the list.    When the listbox is dropped as the 
user types any list entries that match are automatically displayed.



Select CD-ROM Drive
This allows users who have more than one CD-ROM drive to select a drive.    All the drives 
attached to the system will be displayed.    The user must select the drive for CD Wizzard in 
order to use this.



Shuffle Mode
The shuffle mode of playback will play all tracks of the CD in a random order.    Each time the
disc is replayed, a different order will be selected.



Small/Iconized Mode Text Display
This combobox lists the three choices for the Text Display on the Small/Iconized Mode 
Window.    Disc Name, Artist, Composer and Track Name are the choices.



Start playing on startup
This checkbox indicates whether CD Wizzard will automatically start playing a CD when it is 
inserted into the CD-ROM drive.    If selected, it will cause CD Wizzard to start playing when 
CD Wizzard is first executed.    This allows CD Wizzard to be placed in a user's Startup Group 
in Program Manager and have an audio CD begin playing at Windows startup.



Status Bar Display
This is the status bar display.    It will display the current status of the CD player such as 
playing, stopped, etc.    It will also display short help messages when the mouse cursor is 
dragged over certain areas on the window or on menu items, if the user has the Status Bar 
Help Text option turned on in the Layout Options..



Status Bar Help Text
When selected, help messages are displayed on the status bar as the mouse is dragged over
different areas of the screen.    These messages explain about the various areas of the main 
window that can be clicked on.



Stop playing on exit
This checkbox indicates whether CD Wizzard should stop playing on exit from the program.



Text Color
These radio buttons allow the user to select the color of the text in the Disc Name, Track 
Name, and Status Bar areas on the main window.    The color choices are black, blue, and 
red.    When a color is selected, a preview of the text color is displayed.

The embossed text checkbox indicates if the text should be embossed, meaning that it 
would have a 3-D inset.    When the option is changed, a preview of the text is displayed.    
When the text color is black, the background color is black and the text is not embossed, the
text color will be set to white so, the text can be seen.



Text Delimiter
The Text Delimiter dropdown listbox lists the different characters that can be used to 
indicate the start and end of fields in the exported file.    The delimiter may be double quotes
("), single quotes ('), or none.    An example of single quote delimited fields is:

"Field A","Field B","Field C"



Text Display
This is the text of the Disc Name, Artist, Composer or Track Name.    The name to be 
displayed is selected from the Layout Options Dialog.



Time Display
This is the time mode display of CD Wizzard.    This drop down listbox contains the time 
display modes for the main window.    The display is in minutes and seconds.    The user can 
select between the four modes Time Elapsed in Track, Time Remaining in Track, Time 
Elapsed in Disc and Time Remaining in Disc.



Time Mode Display
This is the current time mode.    The four possible modes are Track Elapsed, Track Remaining,
Disc Elapsed and Disc Remaining.    The user clicks on the Time Mode to toggle the next 
mode.    It can also be changed from the Player Options Dialog.



Track Bar Chart
This is a bar chart showing the amount of the track that has been played.    On the main 
window, but not on the icon window, the user can click the left mouse button on the bar 
chart to reposition to that point of the track.



Track Box Display
This is the display of the tracks on the disc.    Any track may be selected by clicking the left 
mouse button on the track number. The selected track will begin to play.

All of the tracks will start out having the LED Color selected in the Display Options Dialog.    
The track that is currently being played will be purple. Tracks that have already been played 
will be gray.

Note: The tracks will not be grayed in Programmed Mode.



Track List
This is a listbox with information on the tracks of the current disc.    The listbox contains the 
track number, name and length for each track.    A user may click on a track and drag it to 
the Programmed Tracks listbox to program that track.    A user may also double click a track 
to add it to the bottom of the Programmed Tracks listbox.



Track Name
This is the name of the track currently being played. This was entered from the Edit Disc 
Data Dialog.



Track Number
This is the display of the current track that is being played.



Track Play List
This listbox contains the order of the tracks currently selected from the disc.    This order will 
be sequential for Normal mode, random for Shuffled mode and chosen order for 
Programmed mode.



Track Play List Edit Control
This edit control contains the order of the tracks currently selected for the disc.    This order 
will be sequential for Normal and Shuffled mode and in a chosen order for Programmed 
mode.    It will also contain the Disc Name and Comments for the disc.

The user can select any part of the edit control and press the Copy button to copy the text to
the windows clipboard.



Track Scrollbar
This is the scrollbar that controls the scrolling of the Track Name entry fields.



Track Time
This is the display of the current time position of the track that is being played.



Trashcan
This is a trashcan icon.    It can be used to remove tracks from the Programmed Tracks 
listbox.    This is done by dragging the track name and dropping it on the trashcan icon.



Volume Display
This is the volume level display. The user clicks the left mouse button on the volume level to 
change the volume.    The volume can also be controlled by the Up and Down buttons in 
large mode.    The volume display device is set in the System Options.



Unused Categories List
This is the list of the categories that are not in use in the database.    The user may wish to 
remove these extra categories from the database by pressing the Delete 
Selectedbutt_deleteselected Button.



User Key
This is the user key.    This a user code that is built from the user's name.    All letters in the 
name are used in the key.    Different spelling and capitalization produce different keys.    For 
example, John Doe, john doe and JOHN DOE produce different keys.    The user sends the Key
to BFM Software which is what the password is generated from.



User Name
This is the user name.    The fields are first name, middle name, and last or surname.    The 
name must be at least eight characters long.    The name can not contain blanks.    All letters 
in the name are used for registration, different spelling and capitalization are significant.



User Password
This is the user password.    The password is sent to the user in the registration package 
when a user registers.    This password allows the user to gain full access to the software.



Tolerant Drive Mode
This checkbox is for use with CD-ROM drives that do not support SEEK commands or other 
CD-ROM drive commands.    The user may use this option if CD Wizzard is getting errors 
when tracks are changed or when skipping through the tracks of the disc.    The user can also
try this option when miscellaneous errors are occurring during playback.

Please see the Common Problems topic for more information.



Buttons - butt_



A/B Button

This button will allow the user to select a portion of a track to be played over and over.    The 
user starts the player playing a track then presses the A/B Button the first time to select the 
start position (the A position).    Next, the user presses the A/B Button again to select the end
position (the B position).    The selection of the track will play over and over until the A/B 
Button is pressed again or any other player button is pressed.



Add All Tracks Button
This button will add all tracks to the end of the Programmed Tracks listbox.



Add Track(s) Button
This button will add all selected tracks to the end of the Programmed Tracks listbox.



Browse for Mixer Button
This button will display a file open dialog so the user can select the mixer program supplied 
with the user's sound card.



Cancel Button
This button will cause the current dialog to be closed.    All information entered on the dialog 
will be discarded and not saved.



Check or Money Order Registration Button
This button will display a dialog with the instructions on how to register CD Wizzard by mail 
with a check or money order.



Clear Button
This button will clear the Mixer Name field.



Clear All Tracks Button
This button will remove all tracks in the Programmed Tracks listbox.



Clear Track(s) Button
This button will remove selected track(s) in the Programmed Tracks listbox.



Close Button
This button will cause the current dialog to be closed.



Compuserve Online Registration Button
This button will display a dialog with the instructions on how to register CD Wizzard online by
using Compuserve's Online registration system.



Copy Button
This button will cause the selected text in the Edit Control to be copied to the windows 
clipboard.



Copy Tracks Button
This button will bring up the Copy Tracks dialog on the selected disc.    All disc information, 
such as Disc Name, Artist, etc. and track information for the current playlist will also be 
displayed.



Credit Card Phone Registration Button
This button will display a dialog with the instructions on how to register CD Wizzard by 
phone with a credit card.



Cue Button
This button will display the Cue Dialog.    The dialog allows an exact position on the CD to be 
Cued or positioned to.



Delete Button
This button will cause all information about the selected disc(s) to be deleted.



Delete Samples Button
This button will cause the CWV file which contains the track samples for this disc to be 
deleted.



Delete Selected Button
This button will cause the Category(s) to be deleted from the database.



Down Button

This button will cause the volume of the CD player to be decreased.    The volume will be 
unmuted, if needed.



Edit Button
This button will bring up the Edit Disc Data dialog on the selected disc.



Edit Disc Data Button
This button will invoke the Edit Disc Data dialog for the disc in the CD player.



Eject / Close Button

If a CD is in the drive, this button will cause the CD to be ejected from the CD player.    Some 
CD-ROM drives have an automatic loading door for those drives.    This button will also close 
the door when a new disc is entered.



Exit Button

 This button will cause CD Wizzard to exit.



Export Button
The Export Button is used to export the data of the selected disc(s) to a file.    The exported 
file can then be imported into any one of many database and word processing products 
currently available.    Almost all of these products support a flat file import.    This allows 
users to utilize the power of the database or word processor to print or create reports on 
their CD collection that is stored in CD Wizzard.

When the Export Button is pressed, a Save As Dialog will allow the user to select the 
exported file's name and location.    Then the Export Options Dialog will allow the user to 
select the format for the exported file such as delimiters and separator characters.    After 
the file has been exported, the user can go to the database or word processor and import 
the file.



Forward Button

This button will cause the CD player to skip forward 15 seconds in the current track.    If the 
button is held down, it will continue to skip forward in 15 second intervals.



Help Button
This button will start the windows help system with help on the current dialog.



Large Button

This button will cause CD Wizzard to go into large mode.    CD Wizzard stays in large mode 
until it is set to small mode again.



Mute Button

This button will will toggle the state of the volume muting.    If the volume is not muted, it 
will be muted (volume level set to zero).    If the volume is muted, it will be restored to the 
previous volume level.



OK Button
This button will cause the current dialog to be closed and for all information on the dialog to 
be saved.



Output Meter Button

This button will cause the output meter to be turned on or off.    Please be aware that the 
output meter takes a lot of system resources.    It may cause your system to slow down when
other applications are executing.



Play / Pause Button

This button will cause the CD player to begin playing, if the CD player was paused or 
stopped.    If the CD player is playing, it will pause playing.



Play Sample Button
This button play the sample of the beginning of the track selected.    A Compressed WAV file 
must have been created by sampling the disc previously.    The quality of the playback will be
somewhat less than the CD due to compression of the sample file.



Play Track Button
This button will cause the CD player to begin playing at the track selected in the listbox.



Program Tracks Button
This button is used to bring up the Program Tracks dialog.    This button is only active when 
the program playing mode is selected.



Register Button
This button will cause the user's name, key and password to be validated and saved in the 
system.    The program will now be registered and all software security will be deactivated.    
When this occurs, the program will be fully functional.



Reverse Button

This button will cause the CD player to skip back 15 seconds in the current track.    If the 
button is held down, it will continue to skip back in 15 second intervals.



Sample All Tracks Button
The button will cause all tracks on the currently inserted disc to be sampled.    The first 5 
seconds of each tracks will be recorded and compressed.    The samples will be saved in a 
CWV (compressed wav file).    The track samples will be able to be played back even when 
the disc is not is the drive.    Samples are very useful in finding a disc to play by listening to 
the sample to determine which disc a track is on.



Save Button
This button will cause all information on the dialog to be saved.



Scan Button

This button will cause the first five seconds of each track in the playlist to be played.    
Pressing the scan button while scanning will cause the track to start playing normally.



Search Button
This button will apply the "Search For" criteria to the disc database and display the discs 
found.



Select All Button
This button will select all entries in the Disc Name Listbox.



Set Tracks Button
This button will clear all currently selected tracks in the Programmed Tracks listbox and then 
create a list of tracks in the Programmed Tracks listbox that equals or comes as close as 
possible to the number of minutes entered.



Small Button

This button will cause CD Wizzard to go into small mode.    CD Wizzard stays in small mode 
until it is set to large mode again.



Start Mixer Button

This button will cause the currently selected mixer program to run.    The mixer program is 
selected in System Options.



Stop Button

This button will cause the CD being played to stop.    The CD player will reset to the first 
track in the sequence.    The CD player can be restarted by pressing the play  button.



Track Forward Button

This button will make the next track the current track.    If the CD player is currently being 
played, the track will begin to play.    If shuffle or programmed is selected, the next track in 
the playlist will be selected to play.



Track Info Button
This will invoke the Track Information Dialog for the tracks currently being played in the CD 
player.



Track Reverse Button

This button will either make the previous track the current track or jump to the beginning of 
the current track if more that 5 seconds have been played.    If the CD player is currently 
being played, the track will continue to play at the new location.    If shuffle or programmed 
is selected, the previous track in the playlist will be selected to play.



Up Button

This button will cause the volume of the CD player to be increased. The volume will be 
unmuted, if needed.
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CD-ROM Installation
CD-ROM Audio in Windows 3.1

This is a complete description of the support for CD-ROM Audio in Windows 3.1.    This article 
will try to completely explain the CD-ROM environment.    It will also include a detailed list of 
things that need to be done to use Music CDs in the user's CD-ROM under Windows 3.1.

The support for CD-ROM Audio is a multilevel cooperation of three levels of drivers.    They 
are the manufacture's CD-ROM device driver, Microsoft's MSCDEX.EXE, and Windows 3.1 
MCICDA.DRV.    These are the three drivers required to use the CD-ROM Audio support in 
Windows 3.1.    The manufacture's driver interfaces directly to the CD-ROM device.    It talks 
to MSCDEX.EXE.    MSCDEX.EXE is the programmer's Red Book CD Audio driver.    It talks to 
MCICDA.DRV of Windows 3.1.    MCICDA.DRV supports Windows applications using CD Audio.   
It talks to Windows programs.    CD Wizzard(TM), a windows application, talks to MCICDA.DRV.

All three drivers must be installed and configured correctly to play music CDs.    When 
Windows 3.1 setup program is run, it checks for the presence of MSCDEX.EXE.    If it is found, 
it will create an entry for MCICDA.DRV in your system.    But, it will NOT install the driver!    
This must be done    after the installation is completed.    CD Wizzard gives instructions on 
how to do this when it detects the situation.    The following are the exact steps to add all 
these drivers to your system:

A) Add the manufacture's driver supplied with the CD-ROM Drive to CONFIG.SYS.
B) Add MSCDEX.EXE from manufacture or Microsoft to AUTOEXEC.BAT.
C) Configure the above drivers for each other. Use the documentation from 

manufacture.
D) Go to Control Panel in windows and select Drivers Icon.
E) Press the ADD Button.
F) Select "[MCI] CD Audio" entry and press OK Button
G) Insert Windows Disk asked for and follow instructions.
H) Restart windows.    CD Wizzard should now be able to run in order to play Music 

CDs.    If the MCICDA.DRV is not yet running after using the above steps, these instructions 
should be followed:

A) Edit SYSTEM.INI.
B) Find the [MCI] section.
C) There should be a "CDAudio=mcicda.drv" entry.    If not, add it.
D) Save SYSTEM.INI and exit editor.
E) Do a directory listing on your <windows>\SYSTEM directory.
F) Is MCICDA.DRV present?    If not:

1) Search Windows 3.1 Install disks for a file    
"MCICDA.DR_".    On 3 1/2 HD it is #4.

2) Use EXPAND.EXE command to expand file to <windows>\SYSTEM.
3) Restart windows.

One major problem that we have seen with CD-ROM drives is that the lens pickup system 
gets dirty easily.    This can cause the CD-ROM drive to act very strange.    It will skip in 
playing songs, reset the drive, or not play a disk at all.    To clean a CD-ROM drive, a CD 
cleaning disc can be bought at most audio stores.    Run the disc through the drive.    This 
should solve the problem.    You should clean your drive at least every 60 days.



Common Problems
This section contains a list of common problems using CD Wizzard.    The following are the 
known problems:

Error Number: 262.    This error is a general CD-ROM Driver error code.    It is usually due to 
the CD-ROM drive not supporting SEEK commands.    Try setting the "Tolerant Drive Mode" 
option in Player Options.    This should remove the error.

CD-ROM players have problems playing some music CD discs.    The player will appear to 
loop or just reset occasionally.    This could be due to a dirty lens pickup system.    Buy a CD 
cleaning disc from an audio store.    Run the disc through the CD-ROM.    If the problem is still 
present, contact the maker of the CD-ROM for service.

Forward and reverse commands take a long time to reposition.    This appears to be a bug in 
some CD-ROM device drivers.    Try setting the "Tolerant Drive Mode" option in Player 
Options.    This should remove the error.

After inserting a disc CD Wizzard does not realize a disc is in the CD-ROM drive.    Try setting 
the "Tolerant Drive Mode" option in Player Options.    This should remove the error.

If CD Wizzard is displaying many different errors and does not seem to work at all, it may be 
due to a bad MCICDA.DRV file.    This file is sometimes corrupted during Windows install.    Try
reinstalling this driver as explained in the second section of CD-ROM Installation.

Data CD-ROM discs do not have the same format as Music CDs.    They will cause a Data Disc
message to be displayed.

While CD Wizzard is playing, during the access to your CD-ROM, your system may slow down
slightly.    This is due to the multimedia extensions of windows.    The slowdown should only 
be minor.

If you see the display of CD Wizzard update but hear no sound, make sure your CD-ROM 
drive's output is hooked up to the input of the sound card.    You can use a simple patch cord 
to connect the line out of the CD-ROM drive to the Line-In of the sound card.    Then set Line-
In of the System Options Dialog.

If the Output Meter display is just a line, then most likely CD Audio source is not selected in 
your mixer.    Press the Mixer Button and select the source CD Audio.

The system slows down when the Output Meter is on.    The Output Meter uses a lot of 
system resources.    Some systems are not able to keep up with the demands of the Output 
Meter and other applications at the same time.    Turn the Output Meter off when other 
applications are run.

The volume control is not working.    This is usally caused by the CD Audio source not being 
set in the System Options Dialog.    Try to set it to Line-In if the drive is connected externally.  
The Drive drive option should be used if the sound card does not have a mixer.



Database errors are occuring.    Use the Verify and Repair Database Command to repair the 
database.



Copyright and Licensing

Copyright © BFM Software 1994
Copyright © Brett McDonald 1994

Following are the system requirements:
1) 386 or higher processor
2) Windows 3.1 or higher
3) Mouse or other pointing device
4) Color monitor - High SVGA resolution recommended.

This software is shareware.    This software is NOT free.    If you like the software and continue
to use it, you MUST register the program.    Registration Fee: $15.95 US.

BFM Software
Brett McDonald
38602 Lancaster Drive
Farmington Hills, MI 48331
Phone: (810) 661-1797

To receive a disk with our latest software add $4.00 to the registration fee.

Please include your name EXACTLY as you want it registered and the generated key from the
registration dialog.

We are a member of the Compuserve Shareware Registration system.    You may register 
BFM Software products with Compuserve.    They will add the fee to your bill and we will send
you the registration.    To access this system, logon to Compuserve and enter "GO SWREG".    
Select Register Shareware.    Search for the keyword "BFM" to find all BFM Software products. 
Then enter the information requested.    Please place your key in one of the extra fields.

Orders with MC, Visa, Amex, or Discover are made by calling Public (software) Library at 800-
242-4775 or 713-524-6394.    This number is for orders ONLY.

Ask to register CD Wizzard product number 11282.    Please give name, address, key, and 
credit card information.    A disk with our latest software will also be shipped for an extra 
$4.00.

PsL will add $20.95 plus $4.00 shipping, if a disc was sent, to your Credit Card bill.    BFM 
Software will send the registration by US Mail within a few days.

Following are our eMail IDs:
Compuserve ID - 73770,1254
American On-line ID - BrettMc
Internet - BrettMc@aol.com

You may distribute this software as long as the following files are included:
CDWREAD.TXT
CDAUDIO.TXT
CDW.EXE
CDW.HLP

All of the above files, must be combined into a single file ZIP or other compression format for
distribution.



Beyond a fee for the reproduction and media cost, no fee may be charged for distribution of 
this software.

This software claims no warranty, implied or otherwise.    This software is provided "AS IS".    
The author claims no responsibility for any damages that might be caused by the use or 
abuse of this software.    This software remains the property of the author.    This software 
may not be modified in any way.



Registration
You may register this product two different ways.    You can mail us a check drawn on a US 
bank or a money order.    If you are a member of Compuserve you can register on-line.

To send us a check use the Registration Dialog that is located under the FILE menu option on
the main menu.    You may also print the Registration Form from help.

We are a member of the Compuserve Shareware Registration system.    You may register 
BFM Software products with Compuserve.    They will add the fee to your bill and we will send
you the registration.    To access this system, logon to Compuserve and enter "GO SWREG".    
Select Register Shareware.    Search for the keyword "BFM" to find all BFM Software products. 
Then enter the information requested.    Please place your key in one of the extra fields.



Registration Form
Note: To print this registration form select FILE then PRINT TOPIC from menu.

CD Wizzard Registration Form

Version: ______

Name to be registered: _________________________________

Generated key: __________

Ship to address: ____________________________________

____________________________________

____________________________________

____________________________________

Please send check or money order for $15.95 US    To:
BFM Software
Brett McDonald
38602 Lancaster Drive
Farmington Hills, MI    48331

To receive a disk with our latest software add $4.00 US



Technical Support
BFM Software will try to help any user to the fullest of our abilities.    We do prefer to help 
registered users with problems concerning our software, but we will try to help anyone we 
can.    Below are the ways a user can contact us:
Electronic Service Compuserve - our ID is 73770,1254
Electronic Service American On-line - our ID is BrettMc
Our mailing address:

BFM Software
Brett McDonald
38602 Lancaster Drive
Farmington Hills, MI 48331

Phone Number: (810) 661-1797
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Menu Commands
These are the menus on the main windows menu bar.
File Menu
Discs Menu
Options Menu
Help Menu

The CD-ROM Controls Menu is added to the system menu for the main and icon window.    
The user simply clicks on the system box at the top of the main window or clicks on the icon 
when iconized.



File Menu
The File Menu includes commands that enable the user to get control of the entire program.  
They are as follows:
Register Command
CD-ROM Controls Menu
Uninstall Command
Exit Command



Register Command
Selecting the Register Command will cause Registration dialog to be displayed. The register 
command is used to register the program.

The register dialog has directions on the steps needed to register the program.    This 
program must be registered after the 15 day trial period.



CD-ROM Controls Menu
These are the menu commands that control the CD-ROM drive.    They are listed below:
Play / Pause - Start playing a CD or Pause playing.
Scan - Play the first five seconds of each track in playlist.
Stop - Stop Playing.
Eject / Close - Eject the current CD or close the drive door.
Track Reverse - Go to the previous track in the playlist.
Track Forward - Go to the next track in the playlist.
Volume Up - Increase the volume of the CD-ROM device.
Mute Volume - Mute/Unmute the volume of the CD-ROM device.
Volume Down - Decrease the volume of the CD-ROM device.



Uninstall Command
Selecting the Uninstall Command from the File Menu will cause a message dialog to be 
displayed.    The user can select YES or NO to uninstall CD Wizzard.

The following files are removed from the user's system in the uninstall processing:
CDWREAD.TXT - text file with miscellaneous CD Wizzard information
CDW.HLP - CD Wizzard help file
CDW.INI - CD Wizzard parameter file
CDW.DDB - CD Wizzard database file
*.CWV - Compressed WAV files for disc samples
CDW.EXE - CD Wizzard program file
CDAUDIO.TXT - Audio installation help file

Note: If SHARE.EXE is installed in the user's system, CD Wizzard will come across an error in
the uninstall process.    SHARE.EXE will not allow a program to access a file that another 
program is accessing.    Windows is executing CDW.EXE so the program cannot access it to 
delete it.    The error message can be ignored and the CDW.EXE file deleted by hand.



Exit Command
Selecting the Exit Command from the File Menu will terminate CD Wizzard.



Discs Menu
The Discs Menu includes commands that enable the user to work with CD Discs.    They are 
as follows:
Display Track Playlist Command
Edit Current Disc Data Command
Copy Track Playlist Command
Disc Database Command
Database Statistics Command
Verify and Repair Database Command



Display Track Playlist Command
This command displays the Track Playlist Dialog with information about the current track 
playlist. This dialog allows the user to select a different track to be played.



Edit Current Disc Data Command
This command displays the Edit Disc Data Dialog with information about the inserted CD 
Disc.    This dialog allows the user to change all the information about the disc in the 
database.



Copy Track Playlist Command
This command displays the Copy Tracks Data Dialog to allow the user to copy disc 
information to the windows clipboard.



Disc Database Command
This command displays the Disc Database dialog with all the discs CD Wizzard has saved in 
its database.    This command can be used to delete unwanted discs from the database.



Database Statistics Command
This command displays Database Statistics dialog.    This dialog includes information on the 
disc database.



Verify and Repair Database Command
This command will verify the disc database and repair any problems discovered.    Use this 
command if errors are reported in the disc database.

During the verify and repair process status messages will be displayed on the titlebar of the 
main window.    These messages give an indication of the progress of the verify and repair.



Options Menu
The Options Menu includes commands that enable the user to control options of the 
program.    The options are of the following categories:
Display Options - options to configure the main window's look and feel.
Layout Options - options to configure the main window's layout.
Playback Options - options to configure the playing of CDs.
System Options - options to configure the user's CD-ROM Drive and other system settings.
Database Options - options to configure the disc database.



Help Menu
The Help Menu includes options that enable the user to get help for the program.

For more information, the user should select the Help Menu Command Name:
Help Index Command
Using Help Command
About Command



Help Index Command
The Help Index command is used to invoke the Windows Help engine.    It will start up with 
the help index for CD Wizzard.



Using Help Command
The Using Help command will display help on the Using Windows help system.



About Command
The About command will display a short dialog that displays copyright and registration 
information.    The More button may be pressed to display a picture of the development team
for this software.    The Register button may be pressed to register the software.
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Keyboard
Keyboard commands are shortcuts to the button options.

The following are the keyboard shortcut commands:
Button Short-cut Key

Play / Pause 'Ctrl-P'
Scan 'Ctrl-A'
Stop 'Ctrl-S'
Eject / Close 'Ctrl-E'
Track Reverse 'Ctrl-R'
Track Forward 'Ctrl-F'
Volume Up 'Ctrl-U'
Mute Volume 'Ctrl-M'
Volume Down 'Ctrl-D'
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Mouse
The mouse has a few special functions in CD Wizzard.    In the main window it is used to 
press the buttons.    In certain areas the mouse may be clicked to have special meaning.    
When the  cursor is displayed, these special actions are active.    The Status Bar will have
a short message about what happens in that area, if the user has the Status Bar Help Text 
option turned on in the Layout Options.

When the CD Wizzard icon is displayed, the right mouse button may be pressed on the icon 
to toggle play or pause mode.
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CD Wizzard Definitions
The following are the defined terms of the program:
CD-ROM
CD Wizzard
Clipboard
Disc
Mixer
Output Meter
Playlist
Track



CD-ROM
A CD-ROM stands for Compact Disc Read Only Memory disc.    A CD-ROM drive uses a laser 
beam to read very tiny ones and zeros from the encoded foil layer of the disc.    A CD-ROM 
drive can handle over 650 megabytes of data.



CD Wizzard (tm)

CD Wizzard is a copyrighted work created by BFM Software.

CD Wizzard is a trademark of BFM Software.

Copyright © BFM Software 1994
Copyright © Brett McDonald 1994
All rights reserved by author.



Clipboard
This is the Windows Clipboard.    The clipboard is used to place temporary information that is 
being copied.    A user places information on the clipboard by copying and then pastes the 
information into another program.



Disc
A disc stands for a CD-ROM disc.    Discs come in a few difference types Audio - contain audio
tracks, Data - contain a data track, and Mixed - which contain both a data track and audio 
tracks.    The CD player you might have in your home can only read Audio CDs.    The CD-ROM
in your computer can read all three.



Mixer
A mixer is a program that is used to control the combination of multiple inputs into a single 
output.    CD Audio, WAV output, MIDI, and Line-In are examples of input sources.    The mixer 
combines the inputs into one signal that is sent to the speakers.    A particular input source 
must be selected to record.    This is the same as a home stereo, where the tuner is used to 
select the source to record.    It also sets the volume of each input.



Output Meter
An Output Meter is a graph of the output levels of a signal.    The chart shows the digital 
source in a line graph.    The chart is updated as the signal is received.



Playlist
This is the list of tracks that is currently selected to be played.    In normal mode all tracks 
are played sequentially, in shuffle the tracks are in random order, and in programmed mode 
the tracks are in the order the user selected.



Track
A track is a part of a disc that can contain one song for an audio disc or many files of 
information on a data disc.    A track on CD-ROM is different than a computer disk because 
the tracks spiral together.    Rather, a computer disk has many circular tracks that do not 
intersect.    This is why CD-ROM drives have a much slower access time than computer disk 
drives.




